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1 บทนํา 

1.1 จุดประสงค 

เอกสารฉบับนี ้จ ัดทําขึ ้นเพื ่ออธิบายวิธีการใชงานโปรแกรม DGS-INV2DERT อยางเปนระบบ โดยมี

วัตถุประสงคเพื่อใหผูใชงานสามารถดําเนินกระบวนการอินเวอรชันและการแสดงผลขอมูลไดอยางถูกตองและมี

ประสิทธิภาพ 

1.2 ขอบเขต 

คูมือนี้ครอบคลุมขั้นตอนการติดตั้ง การเปดใชงาน การเตรียมขอมูล การใชงานโมดูล Inversion และ 

Plotting รวมถึงการจัดเก็บและการตีความผลลัพธจากโปรแกรม 

1.3 กลุมผูใชงาน 

เอกสารฉบับนี้เหมาะสําหรับผูใชงานที่มีความรูพื ้นฐานดานการสํารวจธรณีฟสิกส วิศวกร นักวิจัย และ

บุคลากรที่เกี่ยวของกับการประมวลผลขอมูลความตานทานไฟฟา 

1.4 คําจํากัดความและตัวยอ 

คําศัพท คําอธิบาย 

Inversion กระบวนการคํานวณยอนกลับเพื่อประมาณคาคุณสมบัติใตผิวดิน 

RMS Root Mean Square แสดงระดับความคลาดเคล่ือนของขอมูล 

Observed Data ขอมูลจากการสํารวจภาคสนาม 

Model Response ขอมูลสังเคราะหจากแบบจําลอง 
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2 การเปดใชงานโปรแกรม (PROGRAM ACTIVATION) 

2.1 การแสดงหนาตางเปดใชงาน 

เมื่อทําการเปดโปรแกรม DGS-INV2DERT เปนครั้งแรก ระบบจะแสดงหนาตางสําหรับกรอกขอมูลรหัสเปด

ใชงาน (Activation Code) ดังแสดงในรูปที่ 1 เพื่อใชในการลงทะเบียนและยืนยันสิทธิ์การใชงานโปรแกรม 

 
รูปที่ 1 แสดงหนาตางสําหรับกรอกรหัสเปดใชงาน เมื่อทําการเปดใชโปรแกรม DGS-INV2DERT ครั้งแรก 

2.2 รหัสเปดใชงาน (ACTIVATION CODE) 

รหัสเปดใชงานจะถูกจัดสงไปยังที่อยูอีเมลที่ผูใชงานไดทําการลงทะเบียนไวในขั้นตอนการจัดซื้อโปรแกรม 

โดยรหัสเปดใชงานมีคุณสมบัติดังตอไปนี้ 

• สามารถใชงานไดเพียงหนึ่งครั้งเทานั้น 

• ถูกผูกกับคอมพิวเตอรที่ใชในการเปดใชงานโปรแกรม 

• ไมสามารถโอนยายไปใชงานกับอุปกรณอื่นได 

2.3 การยกเลิกการลงทะเบียน 

ในกรณีที่ผู ใชงานมีความประสงคจะยกเลิกการลงทะเบียนการใชงานโปรแกรม หรือมีความจําเปนตอง

เปล ี ่ยนแปลงอ ุปกรณท ี ่ ใช งาน ผ ู  ใช งานจะต องต ิดต อเจ าหน าท ี ่ผ ู ด ูแลระบบโดยตรง ผ านทางอ ี เมล

chatchai.vac@dgs.in.th 

2.4 ขอมูลที่ใชในการเปดใชงานโปรแกรม 

ขอมูลที่จําเปนสําหรับการเปดใชงานโปรแกรมประกอบดวย  

• รหัสเปดใชงาน (Activation Code) 

• ที่อยูอีเมลของผูใชงาน 

ที่อยูอยูอีเมลของผูใชงานจะถูกใชเปนชองทางหลักในการติดตอประสานงานกับเจาหนาที่ ทั้งในดานการ

สนับสนุนทางเทคนิคและการใหบริการหลังการขาย โดยสามารถใชอีเมลเดียวกับที่ใชในการจัดซื้อโปรแกรม หรืออีเมล

อื่นตามที่ผูใชงานกําหนด 

โปรแกรม DGS-INV2DERT ถูกออกแบบใหมีโครงสรางการใชงานแบงออกเปน 2 แถบหลัก (รูปที่ 2) ไดแก 

1. แถบ Inversion ใชสําหรับดําเนินกระบวนการอินเวอรชัน (Inversion Process) และ 

2. แถบ Plotting ใชสําหรับการสรางและแสดงผลภาพกราฟกตาง ๆ 

 
รูปที่ 2 หนาตางโปรแกรม DGS-INV2DERT 

mailto:chatchai.vac@dgs.in.th
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3 การใชงานโปรแกรมในสวน INVERSION 

3.1 โครงสรางเมนูของแถบ INVERSION 

แถบ Inversion ประกอบดวยเมนูการทํางานทั้งหมด 4 เมนูหลัก โดยมีรายละเอียดดังตอไปนี้ 

• File ใชสําหรับเลือกไฟลขอมูลเพื่อเริ่มตนกระบวนการอินเวอรชัน 

• Data Tools ใชสําหรับการปรับแตงและจัดการขอมูลกอนการประมวลผล 

• Model Tools ใชสําหรับกําหนดคาแบบจําลองตั้งตน (Initial Model) ที่ใชในกระบวนการอินเวอรชัน 

• Inversion ใชสําหรับกําหนดคาที่เกี ่ยวของกับกระบวนการอินเวอรชัน ซึ ่งประกอบดวยการตั้งคาหลัก

ดังตอไปนี้ 

o การตั้งคาพารามิเตอร Lambda  

o การตั้งคาเงื่อนไขในการหยุดกระบวนการอินเวอรชัน 

o การตั้งคาโหมดการประมวลผล 

o การตั้งคาตําแหนงสําหรับจัดเก็บผลลัพธของการอินเวอรชัน 

o เมนูสําหรับเริ่มตนกระบวนการอินเวอรชัน 

3.2 การแสดงขอมูลภายหลังการเลือกไฟล 

ภายหลังจากที่ผูใชงานทําการเลือกไฟลขอมูลเรียบรอยแลว โปรแกรมจะแสดงขอมูลที่เกี่ยวของทางดานซาย

ของหนาตางโปรแกรม ซึ่งประกอบดวย  

1. ชื่อโปรไฟลที่เลือก 

2. จํานวนขอมูล 

3. จํานวนขั้วไฟฟา 

4. ประเภทของขอมูล 

5. ประเภทของตําแหนงตามแนวนอน 

6. ระยะหางระหวางขั้วไฟฟาที่นอยที่สุด (Minimum Electrode Spacing) 

7. รูปแบบการจัดวางขั้วไฟฟา 

พรอมกันนี้ โปรแกรมจะแสดงภาพตัดขวางเทียม (Pseudo Section) ของขอมูลที่ผู ใชงานเลือกไวทาง

ดานขวาของหนาตาง ดังแสดงในรูปที่ 3 

ในกรณีที่ขอมูลที่แสดงไมถูกตองหรือไมสอดคลองกับคาที่ใชจริง อาจแสดงวาไฟลขอมูลที่เลือกมีความ

ผิดปกติ ผูใชงานควรทําการตรวจสอบความถูกตองของไฟลขอมูลอีกครั้งกอนดําเนินการตอ 
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รูปที่ 3 แสดงหนาตางของโปรแกรม DGS-INV2DERT หลังจากทําการเลือกไฟลขอมูล 

3.3 การเริ่มตนกระบวนการอินเวอรชัน 

เมื่อไมพบความผิดปกติของขอมูล ผูใชงานสามารถเริ่มตนกระบวนการอินเวอรชันไดโดยเลือกเมนู Inversion 

→ Proceed Inversion ดังแสดงในรูปที่ 4 

 
รูปที่ 4 เมนู Proceed Inversion สําหรับคําส่ังใหกระบวนการอินเวอรชันเริ่มทํางาน 

เมื่อกระบวนการอินเวอรชันเริ่มตนขึ้น โปรแกรมจะรายงานขอมูลและอัปเดตสถานะการทํางานผานทาง

หนาตางดานซาย ขณะเดียวกัน หนาตางดานขวาจะแสดงผลลัพธของการอินเวอรชันในแตละรอบการคํานวณ โดยมี

รายละเอียดดังนี ้ 

• แถวบนดานซาย แสดงภาพตัดขวางเทียมของขอมูลจากการสํารวจ (Observed Data) 

• แถวบนดานขวา แสดงภาพตัดขวางเทียมของขอมูลที ่ไดจากการตอบสนองของแบบจําลอง (Model 

Response) 

• แถวลาง แสดงแบบจําลองสภาพตานทานไฟฟาที่ไดจากกระบวนการอินเวอรชัน (Inverted Model) 

รายละเอียดของผลลัพธดงักลาวแสดงไวในรูปที่ 5 
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รูปที่ 5 แสดงหนาตางโปรแกรมขณะกระบวนการอินเวอรชันกําลังทํางาน โดยโปรแกรมจะทําการรายงานขอมูลและ

อัพเดตสถานะของโปรแกรมผานทางหนาตางดานซายมือ ในขณะที่หนางตางดานขวาจะแสดงผลอินเวอรชันในแตละ

รอบ โดยแสดงภาพตัดขวางเทียมของที่ไดจากการสํารวจ (observed data) ที่แถวบนซายของหนาตาง แสดง

ภาพตัดขวางเทียมของขอมูลที่ไดจากแบบจําลองสภาพตานทานไฟฟา (model response) ที่แถวบนขวาของหนาตาง 

และแสดงแบบจําลองสภาพตานทานไฟฟา (inverted model) ที่แถวลางของหนาตาง 

เมื่อกระบวนการอินเวอรชันเสร็จสิ้น โปรแกรมจะดําเนินการสรุปผลการอินเวอรชันทั้งหมด และเลือก

นําเสนอผลการอินเวอรชันในรอบที่มีคา RMS (Root Mean Square) ตํ่าที่สุด ดังแสดงในรูปที่ 6 

 
รูปที่ 6 แสดงหนาตางโปรแกรม หลังจากที่กระบวนการอินเวอรชันไดทํางานเสร็จส้ิน  
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คา RMS เปนตัวชี้วัดระดับความแตกตางระหวางขอมูลจากการสํารวจภาคสนาม (Observed Data: d) และ

ขอมูลสังเคราะหที่ไดจากแบบจําลอง (Response Data: r) ซึ่งสะทอนถึงระดับความสอดคลองกันของขอมูลทั้งสอง

ประเภท โดยคา RMS ที่ตํ่าแสดงถึงความสอดคลองกันของขอมูลที่สูงขึ้น และบงชี้ถึงคุณภาพของผลการอินเวอรชันที่

ดีขึ้นตามลําดับ ในการประเมินระดับความแตกตางของขอมูล โปรแกรมใชคาฟงกชันความคลาดเคลื่อนของขอมูล 

𝜒𝜒𝑑𝑑ซึ่งคํานวณตามสมการที่ (1)  

𝜒𝜒𝑑𝑑  =  
�∑

(𝑟𝑟𝑖𝑖2  −  𝑑𝑑𝑖𝑖2)
𝑒𝑒𝑖𝑖2
�𝑁𝑁

𝑖𝑖=1

𝑁𝑁
  

(1) 

เมื่อ 𝑒𝑒𝑖𝑖 คือ ความคลาดเคล่ือนของขอมูล และ 𝑵𝑵 คือ จํานวนขอมูลทั้งหมด  

ผลอินเวอรชันทั้งหมดจะถูกจัดเก็บไวในโฟลเดอรที ่ผู ใชงานกําหนดไว ในกรณีที่ผู ใชงานไมไดกําหนด

โปรแกรมจะสรางโฟลเดอร <filename>_inv ไวที่เดียวกับไฟลขอมูลที่เลือก 

 

3.4 ประเภทไฟลขอมูลที่รองรับ (SUPPORTED DATA FILE TYPES) 

ไฟลขอมูลที่สามารถใชงานรวมกับโปรแกรม DGS-INV2DERT ประกอบดวยไฟลขอมูล 2 ประเภท ไดแก 

• ไฟลนามสกุล .dat ซึ่งเปนไฟลขอมูลที่ไดจากโปรแกรม PROSYS II 

• ไฟลนามสกุล .ceg ซึ่งเปนไฟลขอมูลที่ไดรับการออกแบบมาเพื่อรองรับการใชงานกับโปรแกรม DGS-

INV2DERT โดยเฉพาะ 

3.4.1 รูปแบบไฟลขอมูลชนิด DAT (DAT-FILE FORMAT) 

3.4.1.1 ขอกําหนดทั่วไป 

ไฟลขอมูลชนิด DAT เปนไฟลที่สรางขึ้นโดยตรงจากโปรแกรม PROSYS II ไฟลขอมูลดังกลาวมีโครงสราง

และรูปแบบเปนไปตามขอกําหนดที่ระบุไวในหัวขอนี้ รูปแบบตัวอยางแสดงไวในรูปที่ 7 

หมายเหตุ คําอธิบายที่ปรากฏในรูปประกอบใชเพื่อการอธิบายเทานั้น และไมเปนสวนหนึ่งของไฟลขอมูล 

3.4.1.2 โครงสรางไฟลขอมูล 

ไฟลขอมูลชนิด DAT ประกอบดวยขอมูลแบบขอความ (text-based) โดยมีการจัดเรียงขอมูลเปนบรรทัด

ตามลําดับดังตอไปนี้ 

บรรทัดที่ 1 ระบุชื่อแนวสํารวจ ซึ่งผูใชงานเปนผูกําหนด 

บรรทัดที่ 2 ระบุคาระยะหางตํ่าสุดของขั้วไฟฟาที่ใชในการสํารวจ หนวยเปนเมตร 

บรรทัดที่ 3 ระบุรูปแบบของไฟลวาเปนรูปแบบของ PROSYS II 

บรรทัดที่ 4 ระบุชนิดการวางขั้วไฟฟา (electrode configuration) โดยคาที่รองรับมีดังนี้ 

• 1 : Wenner-Alpha 

• 3 : Dipole–Dipole 
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• 7 : Wenner–Schlumberger หรือ Reciprocal Schlumberger 

• 15 : Gradient 

บรรทัดที่ 5 ระบุคําอธิบายของชนิดขอมูลที่กําหนดในบรรทัดที่ 6 บรรทัดนี้  

บรรทัดที่ 6 ระบุชนิดขอมูลที่ใชในการสํารวจ โดยกําหนดคาไดดังนี้ 

• 0 : คาสภาพตานทานไฟฟาปรากฏ (apparent resistivity) 

• 1 : คาความตานทานไฟฟา (resistance) 

บรรทัดที่ 7 ระบุจํานวนขอมูลทั้งหมดในไฟล 

บรรทัดที่ 8 ระบุประเภทของตําแหนงในแนวแกน x โดยกําหนดคาไดดังนี้ 

• 1 : ตําแหนงตามแนวราบ (true horizontal) 

• 2 : ตําแหนงตามพื้นผิว (along surface) 

ตําแหนงตามพื้นผิวใชในกรณีที่แนวสํารวจอยูบนพื้นที่ที่มีความลาดชันหรือภูมิประเทศซับซอน โดยระยะที่

วัดไดตามพื้นผิวอาจมีคามากกวาตําแหนงตามแนวราบ 

บรรทัดที่ 9 ระบุการมีอยูของขอมูลอินดิวซโพลาไรเซชัน (induced polarization; IP) โดยกําหนดคาไดดังนี ้

• 0 : ไมมีขอมูล IP  

• 1 : มีขอมูล IP 

หมายเหตุ ปจจุบันโปรแกรม DGS-INV2DERT ไมรองรับการประมวลผลขอมูล IP 

บรรทัดที่ 10 ระบุขอมูลการวัด ซึ่งประกอบดวย 

• จํานวนขั้วไฟฟาที่ใชในการวัด 

• ตําแหนงในแนวแกน x และ z ของขั้วไฟฟา C1, C2, P1 และ P2 

• คาสภาพตานทานไฟฟาหรือคาความตานทานไฟฟา ตามที่ระบุไวในบรรทัดที่ 6 

ในกรณีที่ไมมีขอมูลสภาพภูมิประเทศ ผูใชงานระบุคา 0 จํานวน 4 คา เรียงตอทายชุดขอมูลการวัด ตามที่

แสดงในรูปที่ 7 หากผูใชงานประสงคจะเพิ่มขอมูลสภาพภูมิประเทศ ดําเนินการไดโดยเพิ่มขอมูลสภาพภูมิประเทศ

ตอทายขอมูลบรรทัดสุดทาย ตามรูปแบบที่แสดงในรูปที่ 8 

การระบุขอมูลสภาพภูมิประเทศ เริ่มตนดวยการระบุจํานวนขอมูลสภาพภูมิประเทศทั้งหมด ตัวอยางเชน ใน

รูปที่ 8 มีขอมูลสภาพภูมิประเทศจํานวน 168 คา จากนั้นระบุขอมูลสภาพภูมิประเทศในรูปแบบสองคอลัมน โดย

คอลัมนที่หนึ่งเปนตําแหนงในแนวแกน x และคอลัมนที่สองเปนตําแหนงในแนวแกน z เมื่อระบุขอมูลสภาพภูมิ

ประเทศครบถวนแลว ผูใชงานใสคา 0 จํานวน 4 คา เรียงตอทายชุดขอมูล เพื่อระบุจุดส้ินสุดของไฟลขอมูล 
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รูปที่ 7 แสดงตัวอยางไฟลขอมูลชนิด dat-file พรอมคําอธิบายความหมายของขอมูลในแตละบรรทัด 

 
รูปที่ 8 แสดงตัวอยางการใสขอมูลสภาพภูมิประเทศใน dat-file 
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3.4.2 รูปแบบไฟลขอมูลชนิด CEG (CEG-FILE FORMAT)  

3.4.2.1 ขอกําหนดทั่วไป 

ไฟลขอมูลชนิด CEG เปนไฟลที่ออกแบบมาเพื่อใชงานกับโปรแกรม DGS-INV2DERT โดยจุดเดนของขอมูล

ไฟลชนิดนี ้คือ งายในการแกไขตําแหนงขั ้วไฟฟา และสามารถใสขอมูลความคลาดเคลื ่อนของขอมูลแตละจุด 

ไฟลขอมูลดังกลาวมีโครงสรางและรูปแบบเปนไปตามขอกําหนดที่ระบุไวในหัวขอนี้ รูปแบบตัวอยางแสดงไวในรูปที่ 9 

หมายเหตุ คําอธิบายที่ปรากฏในรูปประกอบใชเพื่อการอธิบายเทานั้น และไมเปนสวนหนึ่งของไฟลขอมูล 

 
รูปที่ 9 แสดงตัวอยางไฟลขอมูลชนิด ceg-file พรอมคําอธิบายความหมายของขอมูลในแตละบรรทัด 

3.4.2.2 โครงสรางไฟลขอมูล 

ไฟลขอมูลชนิด CEG ประกอบดวยขอมูลแบบขอความ (text-based) โดยมีการจัดเรียงขอมูลเปนบรรทัด

ตามลําดับดังตอไปนี้ 

บรรทัดที่ 1 แสดงประเภทของการสํารวจ สําหรับโปรแกรม DGS-INV2DERT ใหระบุวาเปนการสํารวจ

ประเภท DCR2D เสมอ 

บรรทัดที่ 2 แสดงชื่อของแนวสํารวจ 

บรรทัดที่ 3 ระบุชนิดการวางขั้วไฟฟา (electrode configuration) โดยคาที่รองรับมีดังนี้ 
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• Wenner-Alpha 

• Dipole-Dipole 

• Wenner-Schlumberger 

• Gradient 

บรรทัดที่ 4 ระบุคาระยะหางตํ่าสุดของขั้วไฟฟาที่ใชในการสํารวจ หนวยเปนเมตร 

บรรทัดที่ 5 ระบุจํานวนขอมูลทั้งหมดในไฟล 

บรรทัดที่ 6 ระบุจํานวนขั้วไฟฟาทั้งหมด 

บรรทัดที่ 7 ระบุชนิดขอมูลที่ใชในการสํารวจ โดยกําหนดคาไดดังนี้ 

• Resistivity: คาสภาพตานทานไฟฟาปรากฏ 

• Resistance: คาความตานทานไฟฟา 

บรรทัดที่ 8 ระบุการมีอยูของขอมูลอินดวิซโพลาไรเซชัน (induced polarization; IP) โดยกําหนดคาไดดังนี ้

• No: ไมมีขอมูล IP  

• Yes: มีขอมูล IP 

หมายเหตุ ปจจุบันโปรแกรม DGS-INV2DERT ไมรองรับการประมวลผลขอมูล IP 

บรรทัดที่ 9 ระบุการมีอยูของขอมูลความคลาดเคล่ือนของขอมูล (Data Error) โดยกําหนดคาไดดังนี้ 

• No: ไมมีขอมูลความคลาดเคล่ือน 

• Yes: มีความคลาดเคล่ือน 

บรรทัดที่ 10 ระบุประเภทของตําแหนงในแนวแกน x โดยกําหนดคาไดดังนี้ 

• true horizontal: ตําแหนงตามแนวราบ 

• along surface: ตําแหนงตามพื้นผิว 

บรรทัดที่ 11 ระบุลําดับของขอมูล  

บรรทัดที่ 13 ระบุตําแหนงเริ่มตนในการอานตําแหนงขั้วไฟฟา 

บรรทัดที่ 14-61 ระบุตําแหนงขั้วไฟฟา ซึ่งประกอบไปหมายเลขของขั้วไฟฟา ตําแหนงในแนวแกน x และ z 

(จํานวนบรรทัดตองเทากับจํานวนขั้วไฟฟาที่ระบุไวในบรรทัดที่ 6) 

บรรทัดที่ 63 ระบุตําแหนงเริ่มตนในการอานขอมูลการสํารวจ 

บรรทัดที่ 64-590 ระบุขอมูลการวัด ประกอบดวย 

• หมายเลขขั้วไฟฟา C1, P1, P2 และ C2 

• คาสภาพตานทานไฟฟาปรากฏ หรือคาความตานทานไฟฟา ตามที่ระบุไวในบรรทัดที่ 7  

• คาความคลาดเคล่ือน ตามที่ระบุไวในบรรทัดที่ 9  

การระบุขอมูลสภาพภูมิประเทศ เริ่มตนดวยการระบุจํานวนขอมูลสภาพภูมิประเทศทั้งหมด ตัวอยางเชน ในรูปที่ 10 

มีขอมูลสภาพภูมิประเทศจํานวน 144 คา จากนั้นระบุขอมูลสภาพภูมิประเทศในรูปแบบสองคอลัมน โดยคอลัมนที่

หนึ่งเปนตําแหนงในแนวแกน x และคอลัมนที่สองเปนตําแหนงในแนวแกน z  
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รูปที่ 10 แสดงตัวอยางการใสขอมูลสภาพภูมิประเทศใน ceg-file 

3.4.3 รูปแบบขอมูลตําแหนง 

ขอมูลตําแหนงขั้วไฟฟาและขอมูลสภาพภูมิประเทศ จําเปนตองถูกระบุอยางถูกตอง เนื่องจากมีความสําคัญ

ตอความถูกตองของการประมวลผลขอมูล การระบุขอมูลตําแหนงแยกออกเปนสองแกน ไดแก ตําแหนงในแกนนอน 

(horizontal axis หรือแกน x) และตําแหนงในแกนตั้ง (vertical axis หรือแกน z) 

สําหรับตําแหนงในแกนนอน ผูใชงานสามารถเลือกระบุไดหนึ่งในสองรูปแบบ ไดแก (1) ตําแหนงตาม

แนวราบ (true horizontal, 𝑥𝑥ℎ) และ (2) ตําแหนงตามพื้นผิว (along surface, 𝑥𝑥𝑠𝑠) 

ในกรณีที่แนวสํารวจอยูบนพื้นที่ราบ คาตําแหนงทั้งสองรูปแบบมีคาเทากัน อยางไรก็ตาม ในกรณีที่ภูมิ

ประเทศมีความซับซอน คาตําแหนงทั้งสองมีความแตกตางกัน ดังแสดงในรูปที่ 11 

ตําแหนงตามพื้นผิวสามารถวัดไดโดยตรงจากเทปวัดระยะในระหวางการเก็บขอมูลภาคสนาม ในกรณีที่

ผู ใชงานเลือกใชตําแหนงตามแนวราบ (true horizontal) ในไฟลขอมูล ผู ใชงานตองทําการคํานวณคาตําแหนง

ดังกลาว โดยใชสมการที่ (2) 

 
รูปที่ 11 แสดงระบบพิกัดตําแหนงที่ใชในโปรแกรม โดย 𝑥𝑥ℎ แสดงคาตําแหนงตามแนวราบ (true horizontal), 

𝑥𝑥𝑠𝑠 แสดงคาตําแหนงตามแนวพื้นผิว (along surface) และ z แสดงคาตําแหนงในแนวดิ่ง (vertical axis) โดย

เสนทึบสีเทาแสดงลักษณะของผิวภูมิประเทศ 
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𝑥𝑥ℎ3  =  𝑥𝑥ℎ2  +  �𝑑𝑑𝑑𝑑𝑠𝑠2  −  𝑑𝑑𝑑𝑑2  (2) 

โดยที่คา 𝑑𝑑𝑑𝑑𝑠𝑠 คือผลตางของตําแหนงตามพื้นผิวของสองตําแหนงที่สนใจ (𝑥𝑥𝑠𝑠3  −  𝑥𝑥𝑥𝑥2) และ 𝑑𝑑𝑑𝑑 คือ

ผลตางของความสูงของสองตําแหนงที่สนใจ (𝑧𝑧3  −  𝑧𝑧2) 

สําหรับตําแหนงในแกนตั้ง หรือในแนวแกน z คาตําแหนงมีคาเพิ่มขึ้นตามความลึก โดยคาตําแหนงที่จุดสูงสุด

ของแนวสํารวจมีคาเปน 0 เสมอ ดังที่แสดงในรูปที่ 11 

3.5 การปรับแกขอมูล (DATA CORRECTION) 

โปรแกรม DGS-INV2DERT ไดจัดเตรียมเครื่องมือสําหรับการปรับแกขอมูลอยางเปนระบบ ประกอบดวย

ฟงกชันหลัก ดังตอไปนี้: 

(1) ระบบปรับแกขอมูลอัตโนมัติ (Automatic Correction) 

(2) ระบบปรับแกตําแหนงขั้วไฟฟา (Electrode Position Correction) 

(3) ระบบคัดกรองขอมูลตามคาที่กําหนด (Data Filtering by Value) 

(4) ระบบลบขั้วไฟฟา (Remove Electrode) 

ผูใชงานสามารถเขาถึงและใชงานเครื่องมือดังกลาวไดผานเมนู Data Tools ภายในโปรแกรม (รูปที่ 12) ทั้งนี้ การ

ดําเนินการปรับแกขอมูลควรเปนไปตามขั้นตอนที่กําหนด เพื่อใหมั่นใจในความถูกตองและความนาเชื่อถือของผลการ

ประมวลผล 

 
รูปที่ 12 แสดงเมนูที่เกี่ยวของกับการปรับแกขอมูล 

3.5.1 การปรับแกขอมูลแบบอัตโนมัติ (AUTOMATIC CORRECTION) 

การปรับแกขอมูลแบบอัตโนมัติเปนกระบวนการปรับปรุงคุณภาพขอมูลโดยอาศัยการเปรียบเทียบระหวาง

ขอมูลที ่ไดจากการสํารวจ (Observed Data) และขอมูลที ่ไดจากแบบจําลองสภาพตานทานไฟฟา (Model 

Response) 

กระบวนการปรับแกขอมูลจะดําเนินการโดยพิจารณาคาความแตกตางของขอมูลเปนเกณฑหลัก โดยขอมูลที่

มีคาความแตกตางสูงจะถูกดําเนินการกอน ทั้งนี้ คาขอมูลดังกลาวจะถูกแทนที่ดวยคาเฉล่ียเชิงลอการิทึมของจุดขอมูล

ขางเคียง ทั้งในแนวโปรไฟลและแนวความลึก เพื่อใหคาขอมูลมีความตอเนื่องและสอดคลองกับลักษณะเชิงพื้นที่ 

ภายหลังการปรับแก คาเบี่ยงเบนหรือคาความคาดเคลื่อนของขอมูล (Data Error) จะถูกกําหนดใหมีคา

เทากับรอยละ 10 ของคาขอมูล การปรับแกขอมูลแบบอัตโนมัติรองรับเฉพาะไฟลขอมูลนามสกุล *.ceg เทานั้น  

3.5.2 การปรับแกตําแหนงขั้วไฟฟาแบบ TRN (CORRECT ELECTRODE POSITION (TRN)) 

การปรับแกตําแหนงขั้วไฟฟาแบบ TRN เปนกระบวนการปรับปรุงความถูกตองของตําแหนงและคาระดับ

ของขั้วไฟฟาตามแนวสํารวจ โดยอาศัยขอมูลพิกัดตามแนวสํารวจ (x) และคาระดับ (elevation) ของขั้วไฟฟาแตละ

ตําแหนง 
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ขอมูลตําแหนงและคาระดับของขั้วไฟฟาจะถูกจดัเกบ็ในไฟลนามสกุล *.trn (รูปที่ 13) ซึ่งใชเปนขอมูลอางองิ

ในการปรับแก ทั้งนี้ การปรับแกตําแหนงจะตองดําเนินการใหสอดคลองกับขอมูลในไฟลดังกลาว เพื่อใหมั่นใจใน

ความถูกตองของตําแหนงเชิงพื้นที่และความสอดคลองของผลการประมวลผล ผูใชงานตองตรวจสอบความครบถวน

และความถูกตองของขอมูลในไฟล *.trn กอนดําเนินการ  

 
รูปที่ 13 แสดงตัวอยางไฟลขอมูลชนิด trn-file พรอมคําอธิบายความหมาย สําหรับการปรับแบบ TRN 

3.5.3 การปรับแกตําแหนงขั้วไฟฟาแบบ UTM (CORRECT ELECTRODE POSITION (UTM)) 

การปรับแกตําแหนงขั้วไฟฟาแบบ UTM เปนกระบวนการปรับปรุงความถูกตองของแนวสํารวจ โดยคํานงึถึง

ผลกระทบจากความคดโคงของแนวสํารวจในเชิงพิกัดภูมิศาสตร ทั ้งนี ้ การปรับแกจะอาศัยคาพิกัดตะวันออก 

(Easting) และคาพิกัดเหนือ (Northing) ของขั้วไฟฟาแตละตําแหนงเปนขอมูลหลักในการคํานวณ 

ขอมูลพิกัดและคาระดับ (Elevation) ของขั้วไฟฟาจะถูกจัดเก็บในไฟลนามสกุล *.csv  (รูปที่ 14) ซึ่งใชเปน

ขอมูลอางอิงในการปรับแกตําแหนง โดยผูใชงานตองตรวจสอบความถูกตองและความครบถวนของขอมูลกอน

ดําเนินการ  

 
 

รูปที่ 14 แสดงตัวอยางไฟลขอมูลชนิด csv-file พรอมคําอธิบายความหมาย สําหรับการปรับแบบ UTM 

ขอมูลพิกัดและตําแหนงของขั้วไฟฟาที่จัดเก็บในไฟลนามสกุล *.csv จะถูกนํามาใชเปนขอมูลอางอิงในการ

ปรับแกคาความตานทานไฟฟาปรากฏ (apparent resistivity) ที่ไดจากการสํารวจภาคสนาม 

ภายหลังการปรับแก ขอมูลคาความตานทานไฟฟาปรากฏจะถูกนําไปประมวลผลภายใตสมมติฐานวาแนว

สํารวจมีลักษณะเปนเสนตรง (linear profile) ทั้งนี้ ตําแหนงของขั้วไฟฟาบนแนวสมมุติดังกลาวจะถูกกําหนดโดย

อางอิงจากระยะทางตามแนวราบ (horizontal distance) ระหวางขั้วไฟฟาแตละตําแหนง 

3.5.4 การระบบลบขอมูลเบ้ืองตน (FILTER DATA WITH VALUE) 

ในบางกรณี อาจพบขอมูลที่มีลักษณะผิดปกติ (outliers) ซึ่งมีคาความตานทานไฟฟาปรากฏสูงหรือตํ่าผิดไป

จากแนวโนมของขอมูลโดยรวม อันอาจสงผลกระทบตอความถูกตองของผลการประมวลผล 
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โปรแกรมไดจัดเตรียมเครื่องมือสําหรับการคัดกรองและลบขอมูลเบื้องตน โดยผูใชงานสามารถกําหนด

เงื่อนไขในการคัดกรองขอมูลตามชวงคาที่ตองการ (threshold-based filtering) เชน การลบขอมูลที่มีคามากกวา 

10,000 โอหมเมตร หรือมีคานอยกวา 1 โอหมเมตร การกําหนดเงื่อนไขดังกลาวตองพิจารณาใหเหมาะสมกับลกัษณะ

ของขอมูลและพื้นที่สํารวจ เพื่อใหมั่นใจวาการคัดกรองขอมูลไมสงผลกระทบตอความสมบูรณของขอมูล และยังคง

รักษาความถูกตอง และความนาเชื่อถือของผลการประมวลผล 

3.5.5 การระบบลบขั้วไฟฟา (REMOVE ELECTRODE) 

ในบางกรณี อาจพบขอมูลที่มีลักษณะผิดปกติอันเนื่องมาจากความผิดพลาดของขั้วไฟฟา เชน การชํารุดของ

สายสัญญาณหรือการเชื่อมตอที่ไมสมบูรณ ซึ่งอาจสงผลกระทบตอความถูกตองของขอมูลที่ไดจากการสํารวจ 

โปรแกรมไดจัดเตรียมเครื่องมือสําหรับการลบขั้วไฟฟาที่มีปญหาออกจากชุดขอมูล โดยผูใชงานสามารถ

กําหนดเงื่อนไขในการคัดเลือกขั้วไฟฟาที่ตองการลบได เชน การระบุหมายเลขขั้วไฟฟา (electrode ID) เทากับ 26 

การดําเนินการลบขั้วไฟฟาตองพิจารณาอยางรอบคอบ และควรมีการตรวจสอบความถูกตองกอนและหลัง

การดําเนินการ เพื ่อใหมั ่นใจวาขอมูลที ่เหลืออยู ยังคงมีความสมบูรณ ความนาเชื ่อถือ และสามารถสอบกลับ 

(traceability) ไดอยางเหมาะสม 

3.6 การต้ังคาแบบจําลองต้ังตน 

โปรแกรม DGS-INV2DERT ไดจัดเตรียมเครื่องมือสําหรับการกําหนดแบบจําลองตั้งตนสําหรับกระบวนการ

อินเวอรชัน ประกอบดวยฟงกชันหลัก ดังตอไปนี้  

(1) การเลือกแบบจําลองอางอิง (Prior Model)  

(2) การเพิ่มความละเอียดของกริดในแนวดิง่ (Increase Vertical Resolution)  

(3) การตั้งคาสภาพตานทานไฟฟาของแบบจําลองตั้งตน (Initial Resistivity)  

ผูใชงานสามารถเขาถึงและใชงานเครื่องมือดังกลาวไดผานเมนู Model Tools ภายในโปรแกรม (รูปที่ 15) ทั้งนี้การ

ดําเนินการปรับแกขอมูลควรเปนไปตามขั้นตอนที่กําหนด เพื่อใหมั่นใจในความถูกตองและความนาเชื่อถือของผลการ

ประมวลผล 

 
รูปที่ 15 แสดงเมนูที่เกี่ยวของกับการตั้งคาแบบจําลองตั้งตน 

3.6.1 การเลือกแบบจําลองอางอิง (PRIOR MODEL) 

ตามหลักการของกระบวนการอินเวอรชัน แบบจําลองผลลัพธจะถูกประมาณคาภายใตเงื่อนไขที่ใหความ

แตกตางระหวางขอมูลที่คํานวณไดจากแบบจําลอง (Model Response) และขอมูลที่ไดจากการสํารวจ (Observed 

Data) มีคานอยที่สุด ขณะเดียวกันจะควบคุมใหแบบจําลองผลลัพธมีความแตกตางจากแบบจําลองอางอิง (Prior 

Model) อยูในระดับที่เหมาะสม 

ดังนั้น แบบจําลองอางอิงจึงเปนปจจัยสําคัญที่มีผลตอความเสถียรและความนาเชื่อถือของผลลัพธจาก

กระบวนการอินเวอรชัน 
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ในกรณีที่ผูใชงานตองการกําหนดแบบจําลองอางอิงเฉพาะ ผูใชงานสามารถเลือกใชงานแบบจําลองดังกลาว

ผานเมนู Prior Model ภายในโปรแกรม โดยระบบรองรับเฉพาะไฟลนามสกุล *.m2d เทานั้น 

3.6.2 การเพิ่มความละเอียดของกริดในแนวด่ิง ( INCREASE VERTICAL RESOLUTION) 

ในกรณีที ่ผ ู ใชงานไมไดกําหนดแบบจําลองอางอิง (Prior Model) ระบบจะดําเนินการสรางกริดของ

แบบจําลองทั้งในแนวนอนและแนวดิ่งโดยอัตโนมัติ โดยอางอิงคามาตรฐานที่กําหนดไวภายในโปรแกรม 

อยางไรก็ตาม การกําหนดกริดโดยอัตโนมัติดังกลาวอาจสงผลใหการแบงชั้นของแบบจําลองไมสอดคลองกับ

ขอมูลสนับสนุนอื่น ๆ ดังนั้น โปรแกรมจึงจัดเตรียมฟงกชันสําหรับการเพิ่มความละเอียดของกริดในแนวดิ่ง เพื่อให

ผูใชงานสามารถควบคุมโครงสรางของแบบจําลองไดอยางเหมาะสม 

3.6.3 โหมดอัตโนมัติ (AUTOMATIC INCREASE) 

ในโหมดอัตโนมัติ โปรแกรมจะวิเคราะหระยะหางระหวางขั้วไฟฟาที่มากที่สุดในชุดขอมูล และใชเปนเกณฑ

ในการกําหนดความละเอียดของกริดในแนวดิ่ง โดยกําหนดชวงความลึกและระยะหางของกริดดังนี้: 

• ชวงความลึก 0 – 20 เมตร: เพิ่มกริดทุกระยะ 1 เมตร 

• ชวงความลึก 20 – 40 เมตร: เพิ่มกริดทุกระยะ 2 เมตร 

• ชวงความลึก 40 – 80 เมตร: เพิ่มกริดทุกระยะ 4 เมตร 

• ชวงความลึก 80 – 120 เมตร: เพิ่มกริดทุกระยะ 8 เมตร 

• ชวงความลึกมากกวา 120 เมตร: เพิ่มกริดทุกระยะ 16 เมตร 

3.6.3.1 โหมดกําหนดเอง (MANUAL) 

ในกรณีที่ผูใชงานตองการกําหนดระดับความลึกของกริดในแนวดิ่งดวยตนเอง สามารถดําเนินการผานโหมด

กําหนดเอง (Manual) โดยตองจัดเตรียมไฟลขอมูลนามสกุล *.txt ซึ่งระบุคาความลึกของกริด (หนวย: เมตร) ดังที่

แสดงในรูปที่ 16 

 
รูปที่ 16 แสดงตัวอยางไฟลขอมูลชนิด txt-file สําหรับการเพิ่มกริดในแนวดิ่ง 

จากรูปตัวอยางโปรแกรมจะทําการเพิ่มกริดในแนวดิ่งที่ระดับความลึกที่เมตรที่ 5.0 6.0 และ 7.0 วัดเทียบกับจุดสูงสุด

ของแบบจําลอง 
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3.6.4 การต้ังคาสภาพตานทานไฟฟาของแบบจําลองต้ังตน 

คาสภาพตานทานไฟฟาของแบบจําลองตั้งตนเปนปจจัยที่มีผลตอผลลัพธของกระบวนการอินเวอรชัน 

โดยเฉพาะในบริเวณที่มีความหนาแนนของขอมูลตํ่าหรือมีขอมูลครอบคลุมไมเพียงพอ ซึ่งอาจสงผลตอความเสถียร

และความนาเชื่อถือของแบบจําลองผลลัพธ 

ดังนั้น การประเมินความนาเชื่อถือของแบบจําลองสามารถดําเนินการไดโดยการประมวลผลขอมูลดวยคา

ความตานทานไฟฟาตั้งตนหลายคา (Sensitivity Analysis) เพื่อพิจารณาความคงตัวของโครงสรางสภาพตานทาน

ไฟฟาที่ปรากฏในแบบจําลอง 

ผูใชงานสามารถกําหนดคาความตานทานไฟฟาตั้งตนไดผานเมนู Initial Resistivity ภายในโปรแกรม 

ในกรณีที่ผู ใชงานไมไดกําหนดคาเริ่มตน ระบบจะดําเนินการคํานวณคาความตานทานไฟฟาตั้งตนโดย

อัตโนมัติ โดยใชคาเฉล่ียเชิงลอการิทึม (logarithmic mean) ของขอมูลทั้งหมดเปนคาเริ่มตน 

3.7 การต้ังคาอินเวอรชันพารามิเตอร 

โปรแกรม DGS-INV2DERT ไดจัดเตรียมเครื ่องมือสําหรับการตั ้งคาพารามิเตอรตาง ๆ ที ่เกี ่ยวของกับ

กระบวนการอินเวอรชัน (รูปที่ 17) ดังตอไปนี้  

(1) ตั้งคา Lambda  

(2) เงื่อนไขการหยุดโปรแกรมอินเวอรชัน  

(3) การปรับโหมดการรันอินเวอรชัน  

(4) ตั้งชื่อไฟลที่ใชในการจัดเก็บผลอินเวอรชัน  

(5) ตั้งชื่อโฟลเดอรที่ใชในการจัดเก็บผลอินเวอรชัน 

 
รูปที่ 17 แสดงเมนูการตั้งคาพารามิเตอรตาง ๆ ที่เกี่ยวของกับกระบวนการอินเวอรชัน 

3.7.1 การต้ังคาแลมบดา (LAMBDA SETTING) 

คาแลมบดาเปนพารามิเตอรควบคุมที่มีผลโดยตรงตอกระบวนการอินเวอรชัน โดยทําหนาที่กําหนดสมดุล

ระหวางความสอดคลองของขอมูล (Data Misfit) และความเรียบของแบบจําลอง (Model Smoothness) 

โดยทั่วไป คาแลมบดาจะถูกกําหนดไวลวงหนาโดยผูพัฒนาโปรแกรม อยางไรก็ตาม สําหรับอัลกอริทึม

ประเภท Occam คาแลมบดาจะถูกกําหนดโดยอัตโนมัติผานกระบวนการคนหา (Searching Process) เพื่อใหไดคาที่

เหมาะสมที่สุดในแตละรอบการคํานวณ 

ผูใชงานสามารถกําหนดคาเริ่มตนของการคนหาคาแลมบดาไดผานเมนู Initial Value และสามารถควบคุม

รูปแบบการใชงานคาแลมบดาไดผานเมนู Searching โดยมีเงื่อนไขดังนี้: 

• Searching On: ระบบจะดําเนินการคนหาคาแลมบดาโดยอัตโนมัติในแตละรอบของกระบวนการอินเวอรชัน 

• Searching Off: ระบบจะใชคาแลมบดาคงที่คาเดียวตลอดกระบวนการอินเวอรชัน 
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3.7.2 เงื่อนไขการหยุดโปรแกรมอินเวอรชัน 

โปรแกรมอินเวอรชันจะส้ินสุดการทํางานเมื่อเขาเงื่อนไขอยางนอยหนึ่งในเงื่อนไขตอไปนี้: 

3.7.2.1 เงื่อนไขคาความคลาดเคลื่อน (RMS MISFIT CRITERION) 

ระบบจะหยุดการทํางานเมื่อคาความคลาดเคลื่อนรากกําลังสองเฉลี่ย (Root Mean Square; RMS) อยู

ในชวง 0.95 ถึง 1.05 ซึ่งถือเปนชวงคาที่แสดงถึงความสอดคลองที่ยอมรับไดระหวางขอมูลจากการสํารวจและขอมูล

จากแบบจําลอง 

3.7.2.2 เงื่อนไขการเบ่ียงเบนของคา RMS (RMS DIVERGENCE CRITERION) 

ระบบจะหยุดการทํางานเมื่อพบวาคา RMS มีแนวโนมเพิ่มขึ้นจากคาที่ตํ่าที่สุดที่เคยได โดยคาเริ่มตนระบบ

กําหนดใหหยุดเมื่อคา RMS เพิ่มขึ้นตอเนื่องเปนจํานวน 1 รอบการคํานวณ 

เงื่อนไขดังกลาวเหมาะสมสําหรับกรณีที่ขอมูลมีคุณภาพดี อยางไรก็ตาม ในกรณีที่ขอมูลมีสัญญาณรบกวน

หรือมีคุณภาพตํ่า คา RMS อาจมีการปรับตัวเพิ่มขึ้นชั่วคราวกอนลดลงอีกครั้ง ดังนั้น ผูใชงานสามารถปรับจํานวนรอบ

ที่อนุญาตใหคา RMS เพิ่มขึ้นไดผานเมนู Stop Condition → Maximum Diverge 

3.7.2.3 เงื่อนไขจาํนวนรอบสูงสุด (MAXIMUM ITERATION CRITERION) 

ระบบจะหยุดการทํางานเมื่อดําเนินการครบจํานวนรอบสูงสุดที่กําหนดไว โดยคาเริ่มตนโปรแกรมกําหนด

จํานวนรอบสูงสุดไวที่ 20 รอบ 

ผูใชงานสามารถปรับจํานวนรอบสูงสุดไดผานเมนู Stop Condition → Maximum Iteration เพื ่อให

เหมาะสมกับลักษณะของขอมูลและความตองการในการวิเคราะห 

3.7.3 การปรับโหมดการรันอินเวอรชัน 

นอกจากการรันอินเวอรชันแบบปกติ โปรแกรมมีโหมดการรันในใชงานอีก 3 โหมด อันไดแก (1) Multi-

Data-Single-Model เปนโหมดการรันอินเวอรชันที่นําขอมูลจากหลายไฟลขอมูลมาประมวลผลอินเวอรชันรวมกัน 

(2) Pattern-Constrained Inversion เปนโหมดการรันที่เปลี่ยนรูปแบบการวัดสัญญาณจากความแตกตางของขอมูล 

เปนการวัดความแตกตางของรูปแบบสัญญาณ ซึ่งชวยทําใหไดแบบจําลองที่มีคาความเชื่อถือ เมื่อขอมูลถูกปนเปอน

ดวยสัญญาณรบกวนจํานวนมาก และ (3) Time-lapse Inversion เปนโหมดการรันเพื่อใหไดมาของความแตกตาง

ของแบบจําลอง สําหรับรายละเอียดในการใชงานจะอธิบายในหัวขอโหมดการรันอินเวอรชัน 

3.7.4 ต้ังชื่อไฟลที่ใชในการจัดเก็บผลอินเวอรชัน 

ผูใชงานสามารถกําหนดชื่อไฟลผลลัพธที ่ไดจากกระบวนการอินเวอรชันผานเมนู Save Name ภายใน

โปรแกรม 

ในกรณีที่ผู ใชงานไมไดกําหนดชื่อไฟล ระบบจะดําเนินการตั้งชื่อไฟลโดยอัตโนมัติ โดยใชชื่อไฟลขอมูล

ตนฉบับรวมกับอักขระ “_” เพื่อใชเปนชื่อไฟลผลลัพธจากกระบวนการอินเวอรชัน 
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3.7.5 ต้ังชื่อโฟลเดอรที่ ใชในการจัดเก็บผลอินเวอรชัน 

ผูใชงานสามารถกําหนดโฟลเดอรสําหรับจัดเก็บผลลัพธที่ไดจากกระบวนการอินเวอรชันผานเมนู Save Path 

ภายในโปรแกรม 

ในกรณีที่ผูใชงานไมไดกําหนดโฟลเดอร ระบบจะดําเนินการสรางโฟลเดอรโดยอัตโนมัติ ณ ตําแหนงเดียวกับ

ไฟลขอมูลตนฉบับ โดยกําหนดชื่อโฟลเดอรในรูปแบบ <filename>_inv เพื่อใชสําหรับจัดเก็บไฟลผลลัพธจาก

กระบวนการอินเวอรชัน 

3.8 โหมดการรันอินเวอรชัน 

โปรแกรม DGS-INV2DERT มีโหมดการรันอินเวอรชันทั้งส้ิน 4 แบบ ดังตอไปนี้  

1) การรันอินเวอรชันแบบปกติ  

2) การรันแบบ Multi-Data-Single-Model  

3) การรันแบบ Pattern-Constrained  

4) การรันแบบ Time-lapse Inversion  

3.8.1 การรันอินเวอรชันแบบปกติ 

การดําเนินการอินเวอรชันแบบปกติในโปรแกรม DGS-INV2DERT สามารถดําเนินการไดตามขั ้นตอน

มาตรฐานดังตอไปนี้: 

1. ผูใชงานตองเปดไฟลขอมูลที่ตองการประมวลผลผานเมนู File → Open Data 

2. ภายหลังจากโหลดขอมูลเรียบรอยแลว ผูใชงานสามารถเริ่มกระบวนการอินเวอรชันผานเมนู Inversion 

→ Proceed Inversion 

3.8.2 การรันอินเวอรชันแบบ MULTI-DATA-SINGLE-MODEL 

โหมดการประมวลผลขอมูลหลายชุดถูกออกแบบมาเพื่อรองรับกรณีที่ผูใชงานตองการนําขอมูลจากหลายการ

สํารวจมาประมวลผลรวมกัน ซึ่งอาจมีวัตถุประสงคเพื่อเพิ่มความหนาแนนของขอมูลในพื้นที่ศึกษา หรือเพื่อวิเคราะห

และเปรียบเทียบแบบจําลองจากขอมูลที่ไดในชวงเวลาที่แตกตางกัน 

การดําเนินการในโหมดนี้สามารถทําไดตามขั้นตอนดังตอไปนี้: 

1. ผูใชงานตองเปดไฟลขอมูลหลักผานเมนู File → Open Data 

2. เพิ่มไฟลขอมูลเพิ่มเติมที่ตองการประมวลผลรวมกันผานเมนู File → Add Data (รูปที่ 18) 

3. ระบบจะแสดงรายการไฟลขอมูลที่ถูกเพิ่มเขามา โดยผูใชงานสามารถเลือกไฟลที่ตองการแสดงผลไดผาน

เมนู File → Select Active File 

4. เมื่อเลือกไฟลขอมูลที่ตองการแลว ผูใชงานสามารถเริ่มกระบวนการอินเวอรชันผานเมนู Inversion → 

Proceed Inversion 

ผลการประมวลผลอินเวอรชันจะแสดงตามไฟลขอมูลที่ถูกกําหนดใหเปนไฟลหลัก (Active File) ในขณะนั้น ในกรณีที่

ผูใชงานไมไดกําหนดตําแหนงจัดเก็บผลลัพธ ระบบจะดําเนินการจัดเก็บไฟลผลอินเวอรชันโดยอัตโนมัติในโฟลเดอร 

DATA_Inv ซึ่งจะถูกสรางขึ้น ณ ตําแหนงเดียวกับไฟลขอมูลลาสุดที่ถูกใชงาน 
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รูปที่ 18 แสดงเมนูสําหรับสลับขอมูลที่แสดง 

3.8.3 การรันแบบ PATTERN-CONSTRAINED 

โหมดการประมวลผลแบบ Pattern-Constrained Inversion ถูกออกแบบมาเพื่อรองรับกรณีทีข่อมูลสํารวจ

มีสัญญาณรบกวนในระดับสูง ซึ่งสงผลใหขอมูลจํานวนมากมีคาความคลาดเคลื่อนสูง และอาจทําใหผลลัพธจากการ

ประมวลผลแบบปกติขาดความนาเชื่อถือ (รูปที่ 19) 

การใชงานโหมดนี้ชวยควบคุมรูปแบบของแบบจําลองใหมีความสอดคลองเชิงโครงสรางมากขึ้น ซึ่งเหมาะสม

สําหรับขอมูลที่มีคุณภาพตํ่าหรือมีการปนเปอนของสัญญาณรบกวน 

1. การดําเนินการสามารถทําไดตามขั้นตอนดังตอไปนี้: 

2. ผูใชงานตองเปดไฟลขอมูลผานเมนู File → Open Data 

3. เปดใชงานโหมด Pattern-Constrained ผานเมนู Inversion → Pattern-Constrained Off 

4. เมื ่อเลือกเมนูดังกลาวแลว ระบบจะเปลี่ยนสถานะเปน Pattern-Constrained On เพื่อแสดงวาโหมด

ดังกลาวถูกเปดใชงาน 

5. ผูใชงานสามารถเริ่มกระบวนการอินเวอรชันผานเมนู Inversion → Proceed Inversion ไดตามปกติ 

 
รูปที่ 19 ตัวอยางผลการทดสอบตัวการรันแบบ Pattern-Constrained (ก) แบบจําลองสังเคราะหที่ใชในการทดลอง 

(ข) แบบจําลองสภาพตานทานไฟฟาที่ไดจากการรันอินเวอรชันแบบปกติ และ (ค) แบบจําลองสภาพตานทานไฟฟาที่

ไดจากการรันแบบ Pattern-Constrained 
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3.8.4 การรันแบบ TIME-LAPSE 

การประมวลผลแบบ Time-Lapse เปนกระบวนการที่ใชสําหรบัติดตามการเปล่ียนแปลงของโครงสรางใตดนิ

ตามชวงเวลา (รูปที่ 20) โดยอาศัยขอมูลที่ไดจากการสํารวจหลายชวงเวลา (temporal datasets) เพื่อนํามาวิเคราะห

ความแตกตางของแบบจําลอง 

ระบบรองรับการประมวลผลแบบ Time-Lapse จํานวน 2 รูปแบบ ไดแก (1) การกําหนดขอมูลอางอิงโดย

ผูใชงาน และ (2) การประมวลผลแบบอัตโนมัติ 

3.8.4.1 การประมวลผลแบบกําหนดขอมูลอางอิง (USER-DEFINED REFERENCE MODE) 

การดําเนินการมีขั้นตอนดังตอไปนี้: 

1. เปดไฟลขอมูลผานเมนู File → Open Data 

2. เลือกแบบจําลองอางอิงผานเมนู Model Tools → Prior Model 

3. เลือกขอมูลอางอิงผานเมนู Inversion → Time Lapse → Reference Data 

4. เลือกขอมูลตอบสนองจากแบบจําลองอางอิงผานเมนู Inversion → Time Lapse → Reference 

Response 

5. เปดใชงานโหมด Time-Lapse ผานเมนู Inversion → Time Lapse → Time Lapse Off (สถานะจะ

เปล่ียนเปน Time Lapse On) 

6. เริ่มกระบวนการอินเวอรชันผานเมนู Inversion → Proceed Inversion 

3.8.4.2 การประมวลผลแบบอัตโนมัติ (AUTOMATIC MODE) 

การดําเนินการมีขั้นตอนดังตอไปนี้: 

1. เปดไฟลขอมูลผานเมนู File → Open Data 

2. เพิ่มไฟลขอมูลที่ตองการประมวลผลผานเมนู File → Add Data 

3. เปดใชงานโหมด Time-Lapse ผานเมนู Inversion → Time Lapse → Time Lapse Off (สถานะจะ

เปล่ียนเปน Time Lapse On) 

4. เริ่มกระบวนการอินเวอรชันผานเมนู Inversion → Proceed Inversion 

ในโหมดนี้ ระบบจะดําเนินการประมวลผลขอมูลชุดแรกดวยกระบวนการอินเวอรชันแบบปกติหรือแบบ Pattern-

Constrained จากนั้นจะนําผลลัพธของขอมูลชุดกอนหนามาใชเปนขอมูลอางอิงสําหรับการประมวลผล Time-Lapse 

ของขอมูลชุดถัดไป 
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3.8.4.3 การจัดการความไมสอดคลองของขอมูล (DATA CONSISTENCY HANDLING) 

ในการสํารวจแบบ Time-Lapse อาจพบวาขอมูลจากแตละชวงเวลามีความไมสอดคลองกัน ซึ่งอาจทําใหไม

สามารถดําเนินการประมวลผลได 

เพื่อแกไขปญหาดังกลาว โปรแกรม DGS-INV2DERT ไดจัดเตรียมเครื่องมือสําหรับปรับแตงขอมูลใหมีความ

สอดคลองกันโดยอัตโนมัติ โดยผูใชงานสามารถเลือกโหมดการจัดการขอมูลผานเมนู Inversion → Time Lapse 

→ Time Lapse Mode ดังนี้: 

• Repair Data: ระบบจะดําเนินการเติมคาขอมูลที่ขาดหายโดยใชคาเฉล่ียของขอมูลที่เกี่ยวของ 

• Remove Data: ระบบจะดําเนินการลบขอมูลที่ไมสอดคลองออกจากกระบวนการประมวลผล 

คาเริ่มตนของระบบกําหนดใหเปนโหมด Repair Data 

 

 
รูปที่ 20 หนาตางโปรแกรมเมื่อทําการรันแบบ Time Lapse 
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4 การใชงานโปรแกรมในสวน PLOTTING 

แถบการแสดงผล (Plotting) ถูกออกแบบมาเพื่อรองรับการนําเสนอผลการสํารวจและผลการประมวลผลใน

รูปแบบตาง ๆ โดยในปจจุบันรองรับรูปแบบการแสดงผลทั้งหมด 4 รูปแบบ ดังตอไปนี้: 

1. การแสดงผลขอมูล (Data Plot หรือ Response Plot) 

2. การแสดงผลแบบจําลอง (Model Plot) 

3. การแสดงผลขอมูลและผลตอบสนองรวมกัน (Data and Response Plot) 

4. การแสดงผลขอมูล ผลตอบสนอง และแบบจําลองรวมกัน (Data, Response and Model Plot) 

4.1 การเขาถึงและการใชงานเมนู (MENU ACCESSIBILITY) 

เมื่อเขาสูโหมด Plotting ระบบจะเปดใหใชงานเฉพาะเมนูในสวน File เทานั้น โดยเมนูอื่น ๆ จะยังไม

สามารถใชงานไดจนกวาจะมีการโหลดขอมูลเขาสูระบบ 

เมนูที่สามารถใชงานไดมีเงื่อนไขดังตอไปนี้: 

1. เมนู Open Data และ Open Response สามารถใชงานไดทันทีเมื่อเขาสูโหมด Plotting 

2. เมนู Open Model จะสามารถใชงานไดตอเมื่อมีการโหลดไฟลขอมูล (Data) หรือไฟลผลตอบสนอง 

(Response) เรียบรอยแลว 

การกําหนดลําดับการเขาถึงเมนูดังกลาวมีวัตถุประสงคเพื่อควบคุมความถูกตองของขอมูลที่ใชในการแสดงผล และลด

ความผิดพลาดที่อาจเกิดขึ้นจากการใชงานที่ไมสอดคลองกับลําดับขั้นตอน (รูปที่ 21)  

 
รูปที่ 21 แสดงเมนูที่เกี่ยวของกับการอานไฟลขอมูล และแบบจําลอง 

ผูใชงานสามารถปรับรูปในการนําเสนอไดผานทางเมนู Plot Type (รูปที่ 22) ในการปรับแตงคาตาง ๆ 

ตัวอยางเชน Title, X Label, Y Label, คาแถบสีสูงสุดและตํ่าสุด, สัดสวนภาพ, ตําแหนงของแถบสี และสัดสวนของ

ขนาดแถบสีเทียบกับขนาดภาพ ผู ใชงานสามารถปรับคาตาง ๆ ผานหนาตางของโปรแกรม หรือผานทางเมนู  

(รูปที่ 23) 

 
รูปที่ 22 แสดงรูปแบบในการนําเสนอขอมูลที่รับรองในปจจุบัน 
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รูปที่ 23 แสดงหนาตางในการปรับแตงภาพแบบ Data Plot และ Response Plot 

4.1.1 นําเสนอขอมูล (DATA PLOT หรือ RESPONSE PLOT) 

ในการแสดงผลขอมูล ผูใชงานตองดําเนินการโหลดไฟลขอมูลเขาสูระบบกอน โดยสามารถเลือกใชงานผาน

เมนู File → Open Data หรือ File → Open Response 

ภายหลังจากการโหลดขอมูล ระบบจะแสดงผลภาพขอมูลในหนาตางแสดงผลหลักทางดานขวา (รูปที่ 23) 

ขณะที่หนาตางทางดานซายจะแสดงรายการพารามิเตอรและตัวเลือกที่สามารถปรับแตงไดสําหรับการแสดงผล 

พารามิเตอรที่สามารถปรับแตงไดประกอบดวยคาที่เกี่ยวของกับรูปแบบการนําเสนอขอมูล ประกอบดวย 

1. ชื่อ (Title) 

2. คําบรรยายแกนนอน (X-axis Label) 

3. คําบรรยายแกนตั้ง (Y-axis Label) 

4. คําบรรยายแถบสี (Colorbar Label) 

5. คาสภาพตานทานไฟฟาปรากฏตํ่าสุด (Min Rhoa Value) 

6. คาสภาพตานทานไฟฟาปรากฏสูงสุด (Max Rhoa Value) 

7. ปรับอัตราสวนของภาพ (Figure Ratio) 

8. ตําแหนงของแถบสี (Colorbar Location) 

9. ความยาวของแถบสีเทียบกับแกนนอนหรือแกนตั้งของภาพ (Colorbar Shrink) 

10. ความหนาของแถบสี (Color Aspect) 

ซึ่งผูใชงานสามารถปรับแตคาทั้งหมดนี้ผานทางเมนู Adjust Data ไดเชนเดียวกัน (รูปที่ 24) นอกจากนี้ในเมนู Adjust 

Data ยังสามารถปรับคาอื่น ๆ เพิ่มเติม ไดแก 

1. การปรับจํานวนสีในการนําเสนอ ซึ่งมีใหเลือก 10, 17 หรือ 18 สี 

2. การปรับขนาดตัวอักษรของแถบสี 
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รูปที่ 24 แสดงเมนูตาง ๆ ที่อยูในเมนู Adjust Data  

4.1.2 นําเสนอแบบจําลอง (MODEL PLOT) 

ในการแสดงผลแบบจําลอง ผูใชงานตองดําเนินการโหลดไฟลแบบจําลองเขาสู ระบบกอน โดยสามารถ

เลือกใชงานผานเมนู File → Open Model  

ภายหลังจากการโหลดแบบจําลอง ระบบจะแสดงผลภาพแบบจําลองในหนาตางแสดงผลหลักทางดานขวา 

(รูปที่ 25) ขณะที่หนาตางทางดานซายจะแสดงรายการพารามิเตอรและตัวเลือกที่สามารถปรับแตงไดสําหรับการ

แสดงผล 

พารามิเตอรที ่สามารถปรับแตงไดประกอบดวยคาที ่เก ี ่ยวของกับรูปแบบการนําเสนอแบบจําลอง 

ประกอบดวย 

1. ชื่อ (Title) 

2. คําบรรยายแกนนอน (X-axis Label) 

3. คําบรรยายแกนตั้ง (Y-axis Label) 

4. รูปแบบการอางอิงสําหรับปรับคาแกนตั้ง (Reference Type) ซึ่งจะมีคาเริ่มตนเปน Depth และไมสามารถ

ปรับคาไดจนกวาจะมีการระบุคาระดับของขั้วไฟฟาที่ 1 ผานทางเมนู Adjust Model → 1st Electrode 

Elevation 

5. คาความลึกที่นอยที่สุดที่จะแสดง (Min Depth) ในกรณีที่ Reference Type เปนชนิด Depth และเปนคา

ระดับที่สูงที่สุดที่จะแสดง (Max Elevation) ในกรณีที่ Reference Type เปนชนิด Elevation 

6. คาความลึกที่มากที่สุดที่จะแสดง (Max Depth) ในกรณีที่ Reference Type เปนชนิด Depth และเปนคา

ระดับที่ตํ่าที่สุดที่จะแสดง (Min Elevation) ในกรณีที่ Reference Type เปนชนิด Elevation 

7. คําบรรยายแถบสี (Colorbar Label) 

8. คาสภาพตานทานไฟฟาตํ่าสุด (Min Rhoa Value) 

9. คาสภาพตานทานไฟฟาสูงสุด (Max Rhoa Value) 

10. ปรับอัตราสวนของภาพ (Figure Ratio) 

11. ตําแหนงของแถบสี (Colorbar Location) 

12. ความยาวของแถบสีเทียบกับแกนนอนหรือแกนตั้งของภาพ (Colorbar Shrink) 

13. ความหนาของแถบสี (Color Aspect) 

ซึ่งผูใชงานสามารถปรับแตคาทั้งหมดนี้ผานทางเมนู Adjust Model ไดเชนเดียวกัน (รูปที่ 26) นอกจากนั้นในเมนู 

Adjust Model ยังสามารถปรับคาอื่น ๆ เพิ่มเติมได อันไดแก 

1. การปรับจํานวนสีในการนําเสนอ ผานเมนู Colorbar → Number of Color ซึ่งมีใหเลือกแบบ 10, 17 

หรือ 18 สี 

2. การปรับขนาดตัวอักษรของแถบสี ผานเมนู Colorbar → Text Size 
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3. การปรับการแสดงหมายเลขขั้วไฟฟา  

a. หมายเลขขั้วไฟฟาที่ใหทําการแสดงตัวอักษร ผานเมนู Electrode Label → Label Every 

b. ระยะหางตามแนวดิ่งระหวางตัวอักษรกับตําแหนงจริง ผานเมนู Electrode Label → Label 

Offset 

4. ทําการตัดขอบแบบจําลองดวย Model Mask ผานเมนู Model Mask → Mask File และ Model Mask 

→ Mask Level 

5. เพิ่ม Minor Tick ในแนวแกนดิ่ง ผานเมนู Y-axis → Set Minor Tick → Interval  

6. แสดง Minor Tick ในแนวแกนดิ่ง ผานเมนู Y-axis → Set Minor Tick → Display Tick  

7. แสดงกริดในแนวแกนดิ่ง ผานเมนู Y-axis → Display Grid 

8. เลือกแบบจําลองอางอิงเพื่อแสดงผลตางแบบจําลอง Reference Time-Lapse Model 

9. ปรับระดับความแตกตางของแบบจําลองที่จะไมถูกแสดง Time-Lapse Threshold 

10. ปรับการแสดงตําแหนงตามแนวนอนจากระยะทางตามแนวราบ เปนระยะทางในรูปแบบที่ผูใชงานกําหนด

เอง ผานทางเมนู Read xlabel Reference โดยผู ใชงานตองสรางไฟลนามสกุล sta ที ่ระบุหมายเลข

อิเล็กโทรด และคาที่ตองการแสดง (รูปที่ 27) 

11. ทําการเพิ่มเสนในแบบจําลอง เพื่อใชประกอบการแปลความ ผานเมนู Read Line โดยผูใชงานตองสรางไฟล

นามสกุล lin ที่ระบุตําแหนงเริ่มตน และส้ินสุดของเสน (รูปที่ 28) 

 
รูปที่ 25 แสดงหนาตางในการปรับแตงภาพแบบ Model Plot 
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รูปที่ 26 แสดงเมนูตาง ๆ ที่อยูในเมนู Adjust Model  

 
รูปที่ 27 แสดงตัวอยางไฟล sta ที่ใชสําหรับปรับแก tick และ label ในแกนนอน 

 
รูปที่ 28 แสดงตัวอยางไฟล lin ที่ใชสําหรับวาดเสนในแบบจําลอง 

 
รูปที่ 29 แสดงตัวอยางภาพแบบจําลองที่ผานการปรับ โดยอาศัยขอมูลจากไฟลตัวอยางในรูปที่ 27 และรูปที่ 28 

  



คูมือการใชงานโปรแกรม DGS-INV2DERT 

29 

4.1.3 นํา เ สนอข อ ม ู ลท ั ้ ง  DATA แล ะ  RESPONSE ใ น ร ู ป เ ด ี ย ว ก ั น  (DATA AND RESPONSE 

PLOT) 

การแสดงผลในรูปแบบ Data and Response Plot เปนการนําเสนอขอมูลจากไฟลขอมูล (Data File) และ

ไฟลผลตอบสนอง (Response File) ในภาพเดียวกัน เพื่อใชในการเปรียบเทียบความแตกตางระหวางขอมูลกอนและ

หลังการปรับแก (รูปที่ 30) 

รูปแบบการแสดงผลดังกลาวชวยใหผูใชงานสามารถระบุบริเวณที่มีความแตกตางของขอมูลไดอยางชัดเจน 

และสนับสนุนการประเมินคุณภาพของผลการประมวลผล 

หนาตางการแสดงผลในโหมดนี้มีลักษณะคลายกับโหมด Data Plot หรือ Response Plot โดยมีการเพิ่ม

องคประกอบดังตอไปนี้: 

• การแสดงปายกํากับ (label) บริเวณมุมลางซายของภาพ เพื่อระบุประเภทของขอมูลที่นําเสนอ 

• การแสดงคาความแตกตางระหวางขอมูล (data difference) เพื่อใชในการวิเคราะหความคลาดเคลื ่อน

ระหวาง Data และ Response 

 
รูปที่ 30 แสดงหนาตางในการปรับแตภาพแบบ Data and Response Plot 

4.1.4 นําเสนอขอมูลทั้ ง  DATA, RESPONSE และ MODEL ในรูปเดียวกัน (DATA, RESPONSE 

AND MODEL PLOT) 

การแสดงผลในรูปแบบ Data, Response and Model Plot เปนการนําเสนอขอมูลจากไฟลขอมูล (Data 

File) ไฟลผลตอบสนอง (Response File) และไฟลแบบจําลอง (Model File) ภายในภาพเดียวกัน (รูปที่ 31) เพื่อใช

ในการเปรียบเทียบความสอดคลองระหวางขอมูลจริงและขอมูลสังเคราะหที่ไดจากแบบจําลอง 

รูปแบบการแสดงผลดังกลาวชวยสนับสนุนการแปลความแบบจําลอง และการประเมินคุณภาพของผลลัพธ

จากกระบวนการอินเวอรชันไดอยางมีประสิทธิภาพ 
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หนาตางการแสดงผลในโหมดนี้เปนการผสานระหวางโหมด Data Plot/Response Plot และโหมด Model 

Plot โดยมีการเพิ่มองคประกอบดังตอไปนี้: 

• การแสดงปายกํากับ (label) บริเวณมุมลางซายของภาพ เพื่อระบุประเภทของขอมูลที่แสดง 

• การแสดงคาความแตกตางระหวางขอมูลจริงและขอมูลสังเคราะห (data difference) 

• การแสดงคาความคลาดเคล่ือนของแบบจําลองในรูปของคา RMS Misfit 

 
รูปที่ 31 แสดงหนาตางในการปรับแตภาพแบบ Data, Response and Model Plot 
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